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| Runica options
-

] S N |
. N Center for-

Compmxﬂonal
'l EEGLAB v6.0b =[5 Ootion Default Comments Neuroscience
File Edit BGGIEN Plot Datasets Help N
SR Change sampiing rate L ‘extended’ 0 1 is recommended to
Filter the data > find sub-gaussians
. Re-reference
Filenz t

Chan Reject continuous data by eye

‘stop’ 1e-7 final weight change - stop

Frame Extract epochs

Epoch Remowve haseline

Event ‘Irate’ determined too small - too long...
sarnp T

B cermove components from data too large - wts blow up
i?/(e):; Automatic epoch rejection . ,
BN Rcjcct data epochs , maxsteps 512 more channels - more steps
|CA w Reject data using ICA 4
Datas| | 5 ate dipoles using BESA » ‘pca’ Oor Decompose only a
Locate dipoles using DIPFIT 2. » EEG.nbchan  principal data subspace
Laplacian »
FMRIE Tools » .
Other algorithms:
Run ICA decomposition -- pop_runica() binica, jader,erica,sobi,acsobiro
PCA plugir ICAalgorithm to use (click to select) runica =
Commandline options (See help messages) B ERE TE 0 _|
Channel type(s) or channel indices | .. ypes | ... channels |
Cancel | Help | Ok \




Runica progress...

/i V \
S e |
—— o - e C nt .

=R, Computational

Neuroscience

Press Button to interupt runica
Interupt |
e -|E|%

Input data size [33,133175] = 33 channels, 133175 frames/nFinding 33 ICA components using extended ICA,
Kurtosis will be calculated initially every 1 blocks using 6000 data points,
Decomposing 122 frames per ICA weight ({1089)"2 = 133175 weights, Initial learning rate will be 0,001, block size

Learning rate will be multiplied by 0,98 whenever angledelta >= B0 deg.[e - '3
?0"\? t.'han 3%10hagne}£8: deﬁamt 21"2!353(1)!’?19 welght Cgigge 1e-7 step 241 - lrate 0,000002, wchange 0,00000082, angledelta 101.5 deg
raining will end when wchange < 1le-07 or atter steps. step 242 - lrate 0,000001, wchange 0,00000061, angledelta 96,1 deg
Online bias adjustment will be used, step 243 - lrate 0,000001, wchange 0,00000057, angledelta 97,5 deg
Removing mean of each channel ... step 244 - lrate 0,000001, wchange 0,00000054, angledelta 93,7 deg
Final training data range: -171,806 to 179,094 step 245 - lrate 0,000001, wchange 0,00000055, angledelta 100,3 deg
Computing the sphering matrix,., step 246 - lrate 0,000001, wchange 0,00000047, angledelta 96,9 deg
Starting weights are the identity matrix ... step 247 - lrate 0,000001, wchange 0,00000046, angledelta 91,3 deg

step 248 - lrate 0,000001, wchange 0,00000045, angledelta 101.5 deg

Sphering the data ... step 249 - lrate 0,000001, wchange 0,00000041, angledelta 10,1 deg

Beginning ICA training .., first training step may be slow ... ste _

p 250 - lrate 0,000001, wchange 0,00000036, angledelta 95,5 deg
step 1 - Irate 0,001000, wchange 16,85061324, angledelta 0,0 deg step 251 - lrate 0,000001, wchange 000000033, angledelta 92,1 deg
step 2 - lrate 0,001000, wchange 0,26760405, angledelta 0,0 deg step 252 - lrate 0,000001, wchange 0,00000029, angledelta 97,4 deg
step 3 - lrate 0,001000, wchange 0,79058323, angledelta 104,0 deg step 253 - lrate 0,000001, wchange 0,00000030, angledelta 95,8 deg
step 4 - lrate 0,000980, wchange 0,66700031, angledelta 147,2 deg step 254 - lrate 0,000001, wchange 0,00000023, angledelta 94,2 deg
step 5 - lrate 0,000960, wchange 0,62849071, angledelta 146.5 deg SEBP ggg E %r‘ate gggggg% wc:ange ggggggggg ans%ege{ta g;? ges
step 6 - lrate 0,000941, wchange 0,73967955, angledelta 150,7 deg ;ZE 587 - 1::1;2 0. 000001 . 32@:32 0. 00000021 ::glgdzlt: 320 dzg
step ; _ {rate g‘gggggi' wCEange g‘;igéiggg’ angiege{ta %g%'g geg step 258 - lrate 0,000001, wchange 0,00000020, angledelta 99,1 deg
step rate 0, » wchange 0, - angledelta 137,39 deg step 259 - lrate 0,000001, wchange 0,00000019, angledelta 95,0 deg
step 9 - lrate 0,000886, wchange 0,74536137, angledelta 156.0 deg step 260 - lrate 0,000001, wchange 0,00000015, angledelta 98,3 deg

lrate 0,000868, wchange 0,72101402, angledelta 143.7 deg step 261 - lrate 0,000001, wchange 0,00000014, angledelta 99,0 deg
lrate 0,000851, wchange 0,14690114, angledelta 102.5 deg step 262 - lrate 0,000001, wchange 0,00000014, angledelta 94,3 deg
lrate 0,000834, wchange 0,11822100, angledelta 114.3 deg Step ggi - ir‘aze gggggg%, wCEanse gggggggg, ansiegEiféa gii geg
lrate 0,000817, wchange 0,75952966, angledelta 100,6 de step - lrate U, - wchange U, - angledelta Ja,1 deg
Irate 0.000801 . wehangs 026733750, anglodalta 109.1 deg step 265 - lrate 0000001, uchange 0,00000011, angledelta 36,1 deg
lrate 0.000785. wchanae 0.12193751 . analedelta 94.2 de step 266 - lrate 0,000001, wchange 0,00000010, angledelta 94,8 deg
. , g€ . - ang +<_0°9 step 267 - lrate 0,000001, wchange 0,00000010, angledelta 94,5 deg
Irate 0,000763, wchange 0,10285606, angledelta 110.7 deg step 268 - lrate 0,000001, wchange 0,00000010, angledelta 97.7 deg
lrate 0,000754, wchange 0,03770433, angledelta 118.6 deg step 269 - lrate 0,000001, wchange 0,00000008, angledelta 95,1 deg
lrate 0,000739, wchange 0,09544428, angledelta 117,1 deg Sorting components in descending order of mean projected variance ...
Permuting the activation wave forms ...

>>

oy | J
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Evaluating ICA components

Component Scalp Maps & Activity
Component ERP

Component spectral power
Component ERP images
Component ERSP & Coherence

Exercise...
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L Terminal - 0 X

View Terminal

Fil

>>

EEG

e Edit
EEG

setname:
filename:
filepath:
subject:
group:
condition:
session:
comments:
nbchan:
trials:
pnts:

srate:

xmin:

Xmax :

times:

data-
icaact:
icawinv:
icasphere:
icaweights:
icachansind:
chanlocs:
urchanlocs:
chaninfo:
ref:

event:
urevent:
eventdescription:
epoch:
epochdescription:
reject:
stats:
apecdata:
specicaact:
splinefile:
icasplinefile:
dipfit:
history:
saved:

etc:

Tabs Help

'‘faces_4 continuous'
'‘faces_4.set’

' /home/julie/workshop06/ "'
v

L)

[]

[15x48 char]

33

1

133175

250

0

532.6960

[]

[13%1313175 ainalel
[33x123175 single]
[33x323 double]
[32x32 double]
33x323 double]
[1x33 double]
[1x33 struct]
[]

[1x1 struct]

' common '
[1x731 struct]
[1x721 struct]
(0 1y

[]

{}

[1x1 struct]
[1x1 struct]

[]

[]

L)

"

[1x1 struct]
[1x1623 char]
‘not

[]

-~

[<]

Where is the ICA decomp?

) Figure 2

File Edit Yiew |Insert Tools Desktop Window Help
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EEGLAB v6.0b -

File Edit Tools Bl Datasets Help N
Channel locations »

—#1: faces .

Channel data {scroll)

Filename: ...< Channel spectra and maps

Channels pe Channel properties
Frames per ¢ Channel ERP image

Epochs Channel ERPs »
Events
Sampling rat ERP map series >

Epoch start { SumjfCompare ERPs
Epoch end (s

Average refq
Channel locz Component spectra and maps

Component activations (scroll)

ICA weights Component maps

Dataset size Component properties In 32-D
Component ERP image [T
Component ERPs | B

SumjfCompare comp. ERPs

Data statistics »

Time-frequency transforms »

Average time-frequency

Plot component scalp maps in 2-D. — pop_topoplot()

Component numbers 1:12
(negate index to invert component polarity; NaN -> empty subplot; & -1 NuN 3)

Plot title [ ICA Components
Plot geometry (rows,col.); [] -> near square | 0

Plot associated dipole(s) (if present) |

-> Additional tananlarfiiand dis il Cptions Soo NSy

| ‘electrodes’, 'off'

Cancel Help | Ok

Plot ICA scalp maps

S

C
Compmxﬂonal
Neuroscience
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'_V Terminal = M5

File Terminal Go Help

>>

Edit

View

>
>> help topoplot

plot a topographic map of a scalp data field in a 2-D circular view
(locking down at the top of the head) using interpolation on a fine
cartesian grid. Can also show specified channnel location(s), or return
an interpolated value at an arbitrary scalp location (see 'noplot').

By default, channel locations below head center (arc_length 0.5) are
shown in a 'skirt' outside the cartoon head (see 'plotrad' and 'headrad'
options below). Nose is at top of plot; left is left; right is right.

Using option 'plotgrid', the plot may be one or more rectangular grids.

Usage:

>> topoplot (datavector, EEG.chanlocs) ; % plot a map using an EEG chanlocs structure

>> topoplot (datavector,
>> topoplot('example');

'‘my_chan.locs'); % read a channel locations file and plot a map
% give an example of an electrode location file

>> [h grid_or_wval plotrad_or_grid, xmesh, ymeshl= ...

topoplot (datavector, chan_locs, 'Inputl’', 'Valuel', ...);

Required Inputs:

datavector - single vector of channel values. Else, if a vector of selected subset
(int) channel numbers -> mark their location(s) using 'style' 'blank'.
chan_locs - name of an EEG electrode position file (>> topoplot example).
Else, an EEG.chanlocs structure (>> help pop_editset)
- 'absmax' -> gcale map colors to +/- the absolute-max (makes green 0);
‘maxmin’ -> acale colors to the data range (makes green mid-range) ;
[lo.hi] -> use user-definined lo/hi limits (default: ‘'absmax'}
- 'map’ -> plot colored map only
'‘contour' -> plot contour lines only
'both! -> plot both colored map and contour lines
'Fill! -> plot constant color between contour lines
'blank’ -> plot electrode locations only (default: 'both'}
'‘electrodes' - 'on','off', 'labels’', 'numbers’, 'ptalabels’, 'ptanumbers'. To set the 'pts' marker,
see 'Plot detail options' below. {default: 'on' -> mark electrode locations
with points ('.') unless more than 64 channels, then 'off'}.

- vector of channel indices to use in making the head plot.
{default: [] -> plot all chans}
- [channels] Plot channel data in one or more rectangular grids, as

'plotchans’

'plotgrid’

specified by [channels], a position matrix of channel numbers defining

the topographic locations of the channels in the grid. Zero values are

given the figure background color; negative integers, the color of the




Plot ICA scalp maps

File Edit Tools Plot| Datasets Help

Channel locations nter for-
Computational

—No curre Channel data (scroll) Neuroscience
Channel spectra and maps
At e I '
Use "File : prop File Edit View Insert Tools Desktop Window Help

Or "File . Channel ERP image

“f:'l“e‘“;l Channel ERPs Digg|%|@&@@|@|ﬂ@|lﬁl§]
ile > Impc .
T S T ERP map series
::E',jit > Dat: Sum/Compare ERPs 1 2 3 4
File > Sav  component activations (scroll)

= IR it Component spectra and maps
- Reject data: P P P

- Epoch data;  CoOmpanent maps )
- Remove base.  Component properties In 3-D
= Run ICA: Component ERP image ‘
Component ERPs £ —

]

Sum/Compare comp. ERPs
Data statistics
Time-frequency transforms

Average time-frequency
New Time-freq. transforms

b4 Plotcomponent scalp maps in2-D — pop_topoplot() - %

Component numbers 1:12
{negate index to invert component polarity; NaN -> empty subplot; Ex: -1 NaN 3)

]
Plot title [ ICA Components
Plot geometry {rows,col.); [] -> near square | 0
Plot associated dipole(s) (if present) O 0
-> Additional tonanlariiond ool cotions oo i) 5

| ‘electrodes’, 'off'

Cancel Help | Ok | ICA Components




Compare ‘good' and ‘bad’ scalp maps

it View Insert Tools Window Help View Insert Tools Desktop Window Help

g yRaAN®|€ | 0|03

1L

BAD ICA Components ICA Components




Scroll component activities

7 : N
S |
— Centerfor-

Computational
Neuroscience

) NS
EEGLAB v6.0b % Scroll component activities - eegplot() -
. . Figure Display Settings Help
File Edit Tools Datasets Help
. Channel locations ___Uil L ne i ik 13
Channel data (scroll ~—-A~45~ " e Nttt oo
( ) 3 A NAS— W[ [ A f""""""‘l— AN —n
Filename: ...¢ Channel spectra and maps ‘51 "aniig "l 0 ]
3 aook . : B | e
Channels pe Channel properties ; e ] RN o I',‘ A i,_”'“, AR AR e
N e A
Frames per ¢  Channel ERP image q i y o '“ll T T
10 PRI v ] . EA——
2pedie Channel ERPs 11 N L e e e
Events J7 e—— - st -~ foinnn - A
Sampling rat ERP map series 12 PN S Y i "
Epoch start {  SumjCompare ERPs ]g | ————] e S SR it s
g B . | A —-._\_,}‘—M—n—\._m_-n——v—vJ
Epoch end (< Component activations (scroll) }5 bbbk A bk okt Wi A N . ot A ]
Average refe 19 — MRS e B SR s ARl YR SR SR
Channel locz Component spectra and maps 20 prrrs s smns e va———— T R Bt
21 WWW e .
ICA weights Component maps gg o SRS }M vl RN
. —'MWWMM— ( o —Mwﬂmmlo—mﬂ-—w\m
Dataset size Compaonent properties 24 WAWWWWW
Component ERP image 23 i & I SIS gsiot
ndbatiovie L7 e S EUASSNTUINAD bAoA GO
Component ERPs 2 R ¥ G | T
30 o » } N——— v Scale
Sum/Compare comp. ERPs 312 e N SSvnR e M e T
et A A
Data statistics N . . ml , , I[ : ; ml ailleesmenis 0
. -500 0 -100Q -500 0 -1000-500 O -1000-500 O -1000-500 O -1000
Time-frequency transforms
A ti § Chan. Time Value -
WErage time-irequency CANCELI Event types| =<| =l 111/ =1 ==| 1 45032 -1867 | 12 = REJECT I
Cluster dataset |Cs L
J

Activity like this that is not separated by ICA should be
removed and ICA run again for better decomposition
10



Plot ICA component properties

7 \»\ A N

/ \ s/
- ~ " Trial 1
/ \ \A % \ A \/

‘\\:,:? :l u ™ IR N —---.. . ERP Image

P WA | Trial 2
TNV AW S

) EEGLAB v6.0b .

File Edit Tools Bl Datasets Help ~ N
Channel locations » ° \\\ /\//\f\ - A A AN NS
—i#1: faces - YRS, M vy
Channel data (scroll) N RTINS ST T
EHARETR o Channel spectra and maps | n N
Channels pe|  Channel properties ~ = i \/ y /'v AN VA
. o o IR, v \/
Frames per<  Channel ERP image File Edit View Ins um m mmm aumm o ssmsses 1o
Es:::ss Channel ERPs » .~
Sampling rat  ERP map series > Component 3 map Component 3 activity (global offset 0. 07513)
Epoch start Sum/Compare ERPs 150 b Il
w .
Epoch end (3 Component activations (scroll) o] 0.9 ,/
Average refe = 100 -
Channel locd  Component spectra and maps ; 0 | %
ICA weights Component maps » bt e e
Dataset size s o0 08
Component ERP image —
=l 1.7 (E-1.8
Component ERPs » 0 i
Sum/Compare comp. ERPs -1.7
Data statistics 4 °l 0 |
Time (ms)
Time-fi t i » .
ime-frequency transforms Activity power spectrum
Awverage time-frequency
Cluster dataset ICs —
o
©
.e ies — @
Component properties — po . [ X =
Component number to plot: T
o))
]
I 3 | >
-20 | L L !
0 10 20 30 40 50
Cancel |  Help | ok | Frequency (Hz)
Cancel | o | ACCEPT]| HELP | oK | 11




Reviewing component properties

(\
S p= g
Center for-

Compmxﬂonal
Neuroscience

EEGLAB v6.0b
File Edit BELIEN Plot Datasets Help N
Change sampling rate L
—#1: 1 _ S
Filter the data »

. Re-reference
Filenz t

Chan Reject continuous data hy eye

Frame Extract epochs
Epock
Event
Samp Run ICA

Remowe haseline

Epoch  Remove components

Epoch . .
Ap Automatic epoch rejection
vera
Chan Reject data epochs »
| CA w Reject data using ICA » Reject components by map
Datas

Locate dipoles using BESA 4 Reject data {all methods)
Locate dipoles using DIPFIT 2.x » Reject by inspection

Laplacian 4 Reject extreme values

FMRIB Tools » Reject by linear trendfvariance
Crand awverage datasets » Reject by probabhility

Locate dipoles using LORETA » Reject by kurtosis

PCA plugin » Reject by spectra

Export marks to data reject

Reject marked epochs

12



Component scalp maps/properties

Confuhaons

Neuroscience

ETE—— = = n
Sy e oy o 1 I Pty B s P | QK.
Cancel I SRR e R R R N SeRe A He P
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Component 4 properties

File Edit View Insert Tools

Window Help

Component 4 map

Component 4 activity (global offset 0.036)

Sorted Trials

130 IR o1 = Ame
100 Caee [ e

a0

u W Ausk

2.9
1.3

Z 0

=12

-2.9

Time (ms)

Activity power spectrum

o
=
-
=
E
S
=
-15¢ I I 1 A ey
0 10 20 30 40 50

Cancel |

Frequency {Hz)

.‘%CCEPTl

HELP |

R

Help | 0K |
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Component 9 properties

File Edit View Insert Tools

Window Help

Component 9 map

Component 9 activity (global offset 0.026)

b T TR T Y] .5
T o e
e o M7
0
-0.7
-1.5

Scroll component activities - eegplot()

Figure Display Settings Help
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0
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=]
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| |
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Component 12 properties

File Edit View Insert Tools Window Help

Component 18 properties

File Edit View Insert Tools

Window Help

Component 12 map  Component 12 activity (glowaloffset 0.003)

150 i
re
o ,
=/ 100
e A
-bq—!) s P
5\ 20 i
(/_) b
0.3,
A -0.3

-1

Time {ms)
Activity power spectrum
-10 .
)
=a
L -15F
=]
[=
o4
= "'20 —
| | | |
0 10 20 30 40 50

Frequency {(Hz)

Cancel | A.CCEPT| HELP |

OK|

Component 18 map

Sorted Trials

=
=)

Magnitude (dB)
o
I

20t I

Component 18 activity (globarefiset -0.007)
150 A e e ‘1.8

5044

Time (ms)
Activity-power spectruim

o

10

Cancel |

20 30 40 50
Frequency (Hz)
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File Edit View Insert Tools Window Help

File Edit View Insert Tools

i -B%
Window Help |

Component 17 map Compor“ent 17 activity (global oifzet 0.027)

o ' = ‘
|_ - -
e — JD
2 —
. : . R
N ==,
. -0.3 i
-1 0 1
Time {ms)

Activity power spectrum

Magnitude {dB)

| |
20 30
Frequency (Hz)

0 10

ACCEPTl HELP |

Component 25 map  Comporent 25 activity (global oiset 0.006)
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= 04 - ’. 2 >
. 04 I
1
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Component 12 properties Component 18 properties omponent 17 properties_________________________ ™=EIF38.c: ropertie =O[x
File Edit View Inset Tools Window Help File Edit View Inset Tools Window Help File Edit View Inset Tools Window Help | File Edit View Inset Tools Window Help |
Component 12 map Component 12 activity (global ofiset 0.003) Component 18 map Component 18 activity (global ofiset -0.007) Component 17 map  Component 17 activity (global offset 0.027) Component 25 map  Component 25 activity (global ofiset 0.008)
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File Edit Tools

Channel
—#1: faces
Channel

Filename; ...  Channel

Channels pe Channel
Frames per €  Channel
Epochs
Events
Sampling ray ~ ERPma
Epoch start Sum/fCo ! ! . ! . ; .
EpOCh end (s 19 rMWMWWMWM
Average refe |

Channel locg ~ ©0MRON 20

ICAweights|  Compon A i e e e e e P B

Channel

Dataset size Compon I | | I | I I
22 I ety A g g 9 g e A g A O N AR A i A AP ANV ooy
Compor | | | | | I I
B Ty T N el a1 g L Lt R e et Lam et
compory i | | ! | | | | ZEEE
sum/Co Z4MMWWWWWMMW 12
Data stg 29k l ! l I
Time_fr 4 -t | T T 1 " | T ¥ i | I e | - L aamubml ol | s
— ] -1000 0O -1000 0 -1000 O -1000 0O -1000 O -1000 O -1000 0 1000
Average
Chan. Time YValue
Cluster
CANCEL Eventtypes| |<<| < [52403 =] =>| 11 1g5563 0a3ss | 12 j REJECT |




Export ICA weights

Computaﬂonal
Neuroscience

EEGLAB v6.0b
Edit Tools Plot Datasets Help File name for weight matrix -- pop_expical()
Import data 4 . oo
, lous epochs —— Save In: |C3 data v (&
Import epoch info »
Impaort event info I % faces_3.locs
o ) faces_3.set
n |
[0 Data and ICA activity to text file B faces_4.set
Load existing dataset Weight matrix to text file
Save current dataset(s) Inverse weight matrix to text file
Save current dataset as Write Brain Vis. exchange farmat file
Clear dataset(s) 200
‘96
Create study 4
Load existing studly )
File Name! Ifaces_B.wts ‘
Save current study
i . |All Files
Save current study as 9 A I l 'I
Clear study Save J l ] J
Memaory and other options
Sawve history »
Quit

19



Importing ICA weights

-
& Save |n: ID data vl

- =] faces_3.locs
[£] faces_3.set
) EEGLAB v5.03 =2 faces_4.set

File|Edit Tools Plot Stucy  Datasets Help | B faces.3.wts

Dataset info

——  Ewvent fields inuous
Ewvent values
About this dataset Sf'é<>3p06ffaces_4.set
Channel locations 133175 e e lfaces_gws ‘

Select data 1

7

Files of Type: IAlI Files
) Edit dataset information

Sawve JI Cancelj

Dataset name |

Data sampling rate {(Hz) 250 Subject code

Time points per epoch (0->continuous) 133175 Task condition

|

Start time (sec) {only for data epochs) | 0 Session number
|
I

Number of channels (0->set from data) 33 Subject group

Ref. channel indices or mode (see help) COMMon About this dataset Enter comments |

Channel location file or info From other dataset | | Browse |

MNote: The file format may be auto-detected from its file extension. See menu "Edit > Channel locations" rar other options.

ICA weights array or text{binary file {if any: From other dataset | | ) Browse

ICA sphere array or textfbinary file (if any): From other dataset | | Browse |
Cancel | Help I Ok

20
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Evaluating ICA components

Component Scalp Maps & Activity
Component ERP

Component spectral power
Component ERP images
Component ERSP & Coherence

Exercise...

21
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Component ERPs

'BYEEGLAB v6.03b BEX|
File Edit Tools Plot -“tudy Datasets Help N
Channel locations »
_#1 . SCi Channel data {scroll)
Channel spectra and maps
Filename  Channel properties et
Channels  Channel ERP image
Frames [ channel ERPs »
Epochs ERP map series 4
Events SumfCompare ERPs
Samp"ng Component activations (scroll)
EpOCh st Component spectra and maps
EpDCh er Component maps »
Average Component properties
Cha"“?' Component ERP image )
:;:;:::tgc Component ERPs » With component maps
" Sum{Compare comp. ERPs With comp. maps (compare)
Data statistics »  Inrectangular array

[
A |
Centel

Computational
Neu roscience

Figure 3: Plot > Channel ERPs > In rect. array -- plotdata()

Cluster dataset ICs

Time-frequency transforms '

File Edit View Insert Tools Deskiop Window Help
DEde | M| RKAOOEL-R|0E| ad
sce-animal ERP
FP1 ™t vwm* =7 o ——
FP2 ooyl PZ = o
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01 == A PZ" O e
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5 S
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Definition: The data envelope

7
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Potential (uV)
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N\ Computational
Data (all channels) /\ Seuosene
5 .
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-100 0 100 200 300 400 500 600 700 800 900
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10 I I
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min traces)
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IC contributions to ERP envelope

»

Enter time range {in ms) to plot:

Enter time range {in ms)to rank component contributions: ;
Number of largest contributing components to plot (1-20}): ’
Else plot these component numbers only (<21} (Ex: 2:4,7): {
Component numbers to remove from data before plotting: [
l
l

Plot title:

Optional topoplot{)and spectopo() arguments:

C:%npma;'fon;l
Neuroscience
-100 1000
0 600
6

ERP components of faces_4 epochs

‘electrodes’, 'of f'

File Edit

Wiew Insert Tools Desktop Window Help

Cancel |
L
EEGLAB v6.03b M=l <
File Edit Tools Plot Datasets Help N
Channel locations »
_#1 . SCI Channel data (scroll)

Channel spectra and maps

Filename  Channel properties | set

Channels  Channel ERP image

Frames [  channel ERPs »

Epochs ERP map series »

Events SumjCompare ERPs

Sampling Component activations (scroll)

EpOCh st Component spectra and maps

EpOCh er Component maps »

Average l Component properties

Channe,l Component ERP image

::?:Z;:ZI'[QCI Component ERPs » With component maps

I SumjCompare comp. ERPs With comp. maps (compare)

Data statistics » In rectangular array

|

Time-frequency transforms ~ »
Cluster dataset ICs

DRSS M|RANS® (|08 | = O

Potential (uV)

10

n o

-
=

Largest ERP components of faces_4 epochs




Evaluating ICA components

Component Scalp Maps & Activity
Component ERP

Component spectral power
Component ERP images
Component ERSP & Coherence

Exercise...
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Plot component power

Center for-
specto L Computational
Neuroscience

hd Component spectra and maps —

W A

Epoch time range to analyze [min_ms max_ms]: [ 0532696
Frequency (Hz) to analyze: [ 10

Electrode number to analyze ([=elec with max power; O=whole scalp}): | 0
I
I

Percent data to sample (1 to 100} 20
Components to include in the analysis: 1:33
Number of largest-contributing components to map: S
Else, map only these component numbers:
[Checked] Compute comp spectra; [Unchecked] (data-comp) spectra: 74
Plotting frequency range ([min max] Hz): | 275
Spectral and scalp map options (see topoplot): [ ‘alectrodes’, 'of f'
EEGLAB v6.0b - 15
Cancel | Help | Ok |
File Edit Tools
#2: face Channel locations » D3E§|Q|QQ@@|@|D@|EE
Channel data (scroll) 10.0 Hz
Filename: nc Channel spectra and maps
Channels pe Channel properties
Frames per ¢ Channel ERP image
Epochs
P Channel ERPS »
Events
Sampling rat ERP map series »
Epoch start SumjCompare ERPs 20
-
Epoch end (s Component activations (scroll)
Average refe
Channel locz Component spectra and maps 10
ICA weights Component maps »
Dataset size Component properties

Component ERP image —

Component ERPs »

4
=)

SumjCompare comp. ERPs

Power 10*log y E](,NZIHZJ
o

Data statistics » -20
Time-frequency transforms »
Awverage time-frequency 5 10 15 20

Cluster dataset ICs

Frequency (Hz) _

~




Plot component power

/. N\ \\
| 7
e, -y Centerfor

Computtﬂonal
"y Neuroscience

Epoch time range to analyze [min_ms max_ms]: 0532696
Frequency (Hz) to analyze: 6
Electrode number to analyze ([=elec with max power; O=whole scalp}): 0

Components to include in the analysis: 1:33

Number of largest-contributing components to map: g
Else, map only these compojs

[Checked] Compute comp spec|igh Figure 7: spectopo()

Plotting frequency range ([min R K K .
Spectral and scalp map optiong File Edit Yiew |nsert Tools Desktop Window Help N

EEGLAB v6.0b — D@GQI[‘I\*I@‘Q@@IE‘D@’E@

I
I
I
Percent data to sample (1 to 100} | 20
I
I

File Edit Tools

Channel locations 4 6.0Hz

' ® 9 ®

20 6 17

Channel data (scroll)

Filename: nc Channel spectra and maps

Channels pe Channel properties
Frames per ¢ Channel ERP image

SPOCS Channel ERPs > .

Events

Sampling rat ERP map series »

Epoch start SumjCompare ERPs —_

Epoch end (3 Compaonent activations {scroll) £ 30

Average refe =

Channel locz Component spectra and maps N> 20

ICA weights Component maps » =

H St

Dataset size Component properties = 10
Component ERP image — g"
Component ERPs » g 0
SumfCompare comp. ERPs ':
Data statistics > g -10(=
Time-frequency transforms » 8

[
N
o

Average time-frequency l |
5 10 15 20 25

Erarmiansu (H=)

Cluster dataset ICs




Evaluating ICA components

Component Scalp Maps & Activity
Component ERP

Component spectral power
Component ERP images
Component ERSP & Coherence

Exercise...
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Component ERP image

(\
S p= g
Center for-

Compmxﬂonal
Neuroscience

EEGLAB v6.0b
File Edit Tools Datasets Help N
Channel locations »
—#2: face— N

Channel data (scroll)

Filename: nc Channel spectra and maps

Channels pe Channel properties
Frames per ¢ Channel ERP image

Epochs Channel ERPs »
Events
Sampling rat ERP map series »

Epoch start SumjCompare ERPs
Epoch end (=

Average refq
Channel locz Component spectra and maps

Component activations (scroll)

ICA weights Component maps »
Dataset size Component properties
" Componen: e image
Component ERPs »

SumjCompare comp. ERPs

Data statistics »

Time-frequency transforms 4

Awerage time-frequency

Cluster dataset ICs

29



Trial 1

Trial 2

Trial 3

Trial 4
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Sorted Trials
w
3
]

882.3

ERP Image basics

MR IR IR TRU R 0 e i
IR TR e e e ey e
R I TR mEnny e v s e
(0 L IO UM RO T I NI R RUMLER BN IR )
O Y B0 D) DRI L Y U DL IR L0 10 3 B Y
DRI TR T e e
G EETREEE T AT SV T e i e ey
1 LR 00 B AU R O RLELL AL R D )
B TR A 00O O A T e

i " ||||| I\ | |”\v, =1

No Smoothing

Trial 1:
Triai 2:

Sorted Trials
w
3

'A& - "'w—-—N o -v—-—u—-—'AQ& = —WN

L 1 1 L 1 1 1 1
0 500 1000 1500 -1000 500 0 500 1000 1500
Time (ms) Time (ms)



ERP Images: smoothing across trials

Trials

Trials

Trials

moving average 1
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Neuroscience
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Component ERP Images

Cancel |

L

Ok |==ll

File Edit Tools

11

10

1

I
l
l
I
I

-100U 1996

Sort/align trials by epo.h event values

Figure title

W Plot scalp map
W Plot ERP
W Plot colorbar

ERP limits
Color limits (see Help) |

Epoch-sorting field| Event type(s) | Event time range Rescale Align
[ latency | bpl' 'bp4 | 02000 | no

Sort trials by phase v -0 X

Frequency (Hz | minH select fields amp. trials to

Inter-trial coherenc

_|Don't sort by value
_|Don't plot values

) face
Frequency (Hz | minH object (<0.20)
I
Other options Cancel ] Ok |
Plot spectrum (minH JI. (dB)
. |
Datasets Help N

Channel locations 4

—#2: face

Filename: n¢
Channels pe
Frames per ¢
Epochs
Events
Sampling rat
Epoch start

Channel data {scroll)

Channel spectra and maps
Channel properties

Channel ERP image

Channel ERPs 4
ERP map series »
SumjCompare ERPs

Epoch end (s
Average refe
Channel locg
ICA weights
Dataset size

- Component ERP image —

Component activations (scroll)
Component spectra and maps
Component maps »
Component properties

Component ERPs »
SumjCompare comp. ERPs

Data statistics >

Time-frequency transforms »

Awverage time-frequency

Cluster dataset ICs

File Edit

Wiew

Insert  Tools

Desktop  Window Help

DRSS LMaMN®|L|(0E| 0O
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300F

200

150 |

Sorted Trials
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Component ERP Images

Component ERPimage -- pop_erpimage()

Component(s) | 3
Project to channel # | Figure title |
Smoothing | 10 M Plot scalp map
Downsampling | 1 W Plot ERP ERP limits
Time limits {(ms) | 800 1000 W Plot colorbar Color limits (see Help) |
Sort/align trials by epoch event values - 5 T ATl
—sorting fi vant ti
IEPOCh sorting f|eId| | 20826 l | File Edit ¥Yiew Insert Tools Desktop Window Help
D& haaMm® ¥ 08O
Sort trials by phase
Frequency f1iz | minnz maxHz) Percent low-amp. 1

| 10 12 |

Inter-trial coherence options
Frequency (Hz | minHz maxHz) Signif. level {<0.2

Other options
Plot spectrum (minHz maxHz) Baseline ampl. (dB)

Cancel |

Phase-sorted image
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Component ERP Images

Component ERPimage -- pop_erpimage()

Component(s) | 3
Project to channel # |

Smoothing | 10
Downsampling | 1
Time limits {ms) | -300 1000

Sort/align trials by epoch event values

Epoch-sorting field |

Event type(s) |

Event ti

l I

Sort trials by phase
Frequency (Hz | minHz maxHz)

Percent low-amp. 1

l 10 12

Inter-trial coherence options
Frequency (Hz | minHz maxHz)

Signif. level {<0.2

| 10 12

Other options
Plot spectrum (minHz maxHz)

| .01

Baseline ampl. (dB)

Cancel

Phase-sorted

Figure title

W Flot scalp map
W Plot ERP
W Plot colorbar

J)
Eile  Edit

Wiew

Insert  Tools

ERP limits

Color limits (see Help) |

Figure 3: erpimage()

Desktop  Window Help

Ded& hRAM®|(E|DE| =8O
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Figure 3: erpimage()

Com onent E RP ile Edit ¥iew Inset Tools Desktop Window Help ~
p D& hRaO® |08 s™
, , Phase-sorted
Component ERPimage -- pop_erpimad
alpha power
Component(s) 3 E 5.9
Project to channel # | Figure title i 0
Smoothing | 10 M Plot scalp map 3 =i
Downsampling 1 W Plot ERP & -11.
Time limits (ms) ~800 1000 W Plot colorbar R VoS
-1.7
) igure 10: erpimage - 7 .
y Figure 10: erpimage() O X & o 0.33‘8_1._@______‘_,—\ P
File Edit View Insert Tools Desktop Window Help - e N
-10
D& haam®|E| 08| =0 ‘
o :
=
% Same data: Sorted by alpha amplitude 0 el el
Time {ms)
- Comp. 3
© 16.8
5 il 5.4
% 200 HEB) Coher limits {<=1) .|mage amps
& : 0 | {Requires signif.)
S 100f -84
g 16,
< 17 More options (see > > help erpimage)
L ‘ampsort' , [0 0 10 12]
-1.7
B -0.3381 dB | O |
G0 ’\\ >> help erpimage
- o ‘ampsort’ = [center_m,s prcnt, freq, maxfreq] Sort epochs by amplitude.
1 (See 'phasesort' above). If ms_center is 'Inf', then sorting
2 C is by mean power across the time window specified by 'sortwin’
U_agg 600 -400 -200 0 200 below. If third arg, freq, is <0, sort by mean power in the range
Time {(ms)

[ abs(freq)

maxfreq ].




Component ERP Images

) Component ERPimage -- pop_erpimage() = | [T} | P

Component(s) | 3

Project to channel # | Figure title |

Smoothing | 10 W Plot scalp map

Downsampling | 1 W Plot ERP ERP limits

Time limits {ms) | -800 1000 W Plot colorbar Color limits (see Help) |

Figure 10: erpimage() J Figure 11: erpimage()

File Edit ¥Yiew |nsert Tools Desktop Window Help File Edit ¥Yiew Insert Tools Desktop Window Help N

bed §| & | a’d Same sorting order: Amplitude vs. activations 2 | E| - E‘ =0
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Evaluating ICA components

Component Scalp Maps & Activity
Component ERP

Component spectral power
Component ERP images
Component ERSP & Coherence

Exercise...
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Plot IC ERSP

) Figure 2 - 0O X
File Edit ¥Yiew Insert Tools Desktop Window Help N
Ded& hRAM®|E|DE| =8O s
euroscience
Component 1 power and inter-trial phase coherence {faces n epochs) ERSP(dB)
90
| 5

W B
o o

p—y
o

Freguency (Hz)
(]
o
.
?}
clrl o
dB
r.ln o

2040
dB

0 a00 1000
Time (ms) TC
au
g 40 04
=z &
(= g—
S 20 0.2
=
Q
w 10
F T =6 0 -
0 0.1 . pop_newtimef() —|[=
ERP [ B ST ¥
0 a00 1000 1
Time (ms) 1000 1996
w = ; 305
[set]-=Linear coher / [unset]-=Phase coher |
Bootstrap significance level {(Ex: 0.01 -= 1%) | 01
Optional newtimef( arguments (see Help) ['padratio’, 2, 'plotphase’,'off','winsize', 250 | / Help |
W Flot Event Related Spectral Power W Flot Inter Trial Coherence
Cancel | Help | Ok,




IC cross coherence

S re
- Center for-

Computational
3 ) Neuroscience

Plot component cross-coherence -- pop_newcrossf()

Al Izl ek First component number [ 1
q Second component number 2
—i#6: faces, E . : |
q poch time range [min max] {(msec) | ~1080.2996
: h Wavelet cycles (0-=FFT, see == help timef) | 205
gl'uenamle' ng ) [set]-=Linear coher / [unset]-=Phase coher B
annels pe Bootstrap significance level {(Ex: 0.01 -> 1%)
Frames per¢ ¢ . : -
Epochs Optional timef() arguments {(see Help) '‘padratio’, 1 Hel
(
Events
Sampling rat B W Plot coherence amplitude W Plot coherence phase
Epoch start{ 9
Epochend (¢ Cancel | Help | Ok
Average refe
Channel locz L ™~ ™
ICA weights Component maps »
Dataset size Component properties
Component ERP image
Component ERPs »
SumjCompare comp. ERPs
Data statistics »
Time-frequency transforms 4 Channel time-frequency
Awverage time-freguency Channel cross-coherence
Cluster dataset ICs Component time-frequency
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File

—#6: faces

Edit Tools

Filename: nc
Channels pe
Frames per ¢
Epochs

Events

Sampling rat
Epoch start
Epoch end (s
Average refe
Channel locz
ICA weights
Dataset size

IC cross coherence

EEGLAB v6.0b

Plot Datasets Help

Channel locations »

Channel data (scroll)

Channel spectra and maps
Channel properties

Channel ERP image

Channel ERPs 4
ERP map series »
SumjfCompare ERPs

Component activations {scroll)
Component spectra and maps
Component maps 4
Component properties
Component ERP image
Component ERPs 4
Sum/Compare comp. ERPs

) Figure 3

Eile  Edit

DeEE heaaM®|E| 08| =0

View |nsert Tools Desktop Window Help

L
o o o

Freq. (Hz)

500
Time (ms)

1000
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&
L oap #{ :

50 i B
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Time (ms)

Data statistics »

—|l=l].

Time-frequency transforms »

Average time-frequency
Cluster dataset ICs

Channel time-frequency Be sure to mask by

Channel cross-coherence

Component cross-coherence
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Exercise

ALL
Load faces_3.set or faces 4.set, epoch, reject noise

ALL
-From the GUI, plot component ERPs with maps

-Pick an interesting IC/ERP (e.g. component contributing to
N170) and plot an ERP image of it

-Try sorting by RT or phase, is there any relationship to the IC
actlvatign pattern? What about power in a frequency band of
choice”

Advanced
-Plot cross coherence between two selected Ics studied above

-Compare this result with cross coherence between two
channels that are highly weighted in the respective ICs




